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Figure 31: AxTraxNG™ Software Logon Dialog Box

5. Select an Operator name and enter a Password.

!' By default, the Administrator operator password is "admin®.

Note

6. Click OK.

The main AxTraxNG™ window opens.
4.2 AxTraxNG~ Main Window

The entire central functionality of the AxTraxNG™ system is available from the
AxTraxNG™ Client main window.
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Figure 32: AxTraxNG™ Client Main Window
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System Overview

The AxTraxNG™ Client Main window is divided into six adjustable sections:

Section

1

4.3

Menu Bar

Toolbar

Tree View

Event Log

Display Area

Status Bar

Menu Bar

Description

The Menu bar controls the software’s general operation and
setup. For more information, see Section 4.3.

The main Toolbar consists of icons for the key tasks required in
managing access control across a facility. The available icons
change according to the view selected. For more information,

see Section 4.4.

The Tree View allows users to configure, monitor, and control
every aspect of access control. For more information, see

Section 4.5.

The Event Log displays a detailed log of every time access was
granted or denied for every door on the site, as well as when
inputs and output are opened or closed. The event log toolbar
consists of icons allowing the user to monitor potential door
tamper or forced entry attempts. These warnings are logged
and displayed as internal system warnings, including video
stream archives that are saved to the ViTrax database.

The Display area displays all items within the selected Tree
View element. It also provides options to add, edit, or delete
items manually without opening the detailed element
windows.

In addition, the display area provides various system updates.

The Status Bar displays server connection status, Downloads
Counter, and the Firmware programming progress bar.

The menu bar controls the general operation and setup of the software.

4.3.1

File Menu

The File menu has three options:

Server Connection

ViTrax Server

Exit

Select Menu item to...
Log on to the AxTraxNG™ server
Log on to the ViTrax server

Exit the AxTraxNG™ software
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4.3.2 Tools Menu

Use the Tools menu to manage the database and set software preferences.
The menu has three options:

Menu Select Menu item to...

Database Open the Database window to back up the database or set a
scheduled backup, as well as to import or export the
AxTraxNG™ and/or VeriTrax AS-225/AxTrax AS-525
configuration states and events logs

Options Set software options and preferences, including national
holidays, event highlighting, custom user information fields, and
GUI language

Import/Export Data Import/export user information from/to an Excel spreadsheet file.

4.3.3 View Menu

Use the View menu to define and manage the view of the GUI. The menu has
four options:

Menu Select Menu item to...

Events Check the option to show event logs

Table View Check the option to show a detailed table view
Restore Docking Restore the default GUI view

Close All Floating Close all pop-up windows at once
Windows

4.3.4 Help Menu

The help menu has one option:

Menu Select menu item to...

About View software, firmware, and database version information, as
well as the current operator

4.4 Toolbar

The toolbar controls key tasks required to manage access control across an
entire facility. When a new element is selected from the Tree View, the toolbar
icons change to suit the selected element.

The following toolbar icons are available:
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44.1

icon

4.4.3

icon

& .,.-N’

£ i A

3

C

General Icons

Name Click icon to...

Manual Door Open the Door Manual Operation window (see Section 7.1)
Operation

Print Send the current display area view to the printer
Add Add a new element of the selected type

Edit Edit the selected element

Delete Delete the selected item

General Network Icons

Name Click icon to...

Add to Status Add available panels and panel components to the Status
Map Map (see Section 4.5.6)

Download Failed Download the entire panels’ failed database (see Section
Data Manually 9 )

Network Icons
Name Click icon to...
Set Time Set the time on the selected access control panel (see
Section 9.1)
Find Panels Find and update panels within the network (see Section

Error! Reference source not found.)

Manual Modem Open the Modem Status window to allow the operator to
connect or disconnect the modem and change the

connection password (see Appendix C)

Camera View a list of connected cameras, and assign the cameras to
panels (see Section 6.2)
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4.44 Panel lcons

lcon Name Click icon to...

. Manual Reader Change the operation mode of the readers on the selected
L | panel (see Section 7.2)

J “é Update Send a firmware update to the selected access control panel
i © Firmware (see Section 7.6)

‘Control Output Change the settings for the outputs on the selected panel

1 fl ‘Manually (see Section 7.3)
1.' Control Input ‘Change the settings for the inputs on the selected panel
Ly Manually (see Section 7.4)
: }:! Control Siren Test the siren for the selected panel (see Section 7.5)
+ Manually
4.4.5

Card\Users Icons

lcon Name Click icon to...
User Counter View the current user count value (see Section 9.3)
Add users Create up to 1000 new users in one click (Section 5.10)
Add cards Create up to 1000 new cards in one click (Section 5.10)
Assign cards Add and assign cards to selected users or add cards from

MD-08 (see Appendix F)

User Filter Filter the list of users by various parameters, such as name
and card number (see Section 4.5.5.3)

n P E«r‘ﬁs“@"

4. Reports Icons

lcon Name Click icon to...

Produce Report  produce the selected report (Chapter 8)

' &y

Print Send the current report to the printer

View Last Hour Display relevant access events that occurred within the last
Access hour (Chapter 8)

Note: This icon appears only when a Roli Call -
Readers report is selected.
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Ilcon

4.4.7

Name

View Periodic
Access

Events Icons

Click icon to...

Displays relevant access events that occurred within a
selected time frame (Chapter 8)

Note:
Readers report is selected.

This icon appears only when a Roll Call -

When clicking an event icon, click the dropdown arrow to change the current
view of the display.

lcon

Name

Panel

Access

Alarm

Archive

System

Pause

Refresh

View Events
within the last
Hour

View Events
within the last
Day

View Events
within the last
Week

View Periodical
Events

View All Events

Click icon to...

Display all event types uploaded from the access control
units

Display only access events uploaded from access control
units

Display only alarm events uploaded from access control
units

Display video stream archive events stored in either the
ViTrax database, the USB key, or snapshots saved on PC

Display events related to the AxTraxNG™ Server
operation and operators activity

Halt the display of events in the display area. New events
are shown again when the Pause button is clicked a
second time.

Manually refresh the event list

Display all events that occurred within the last hour. Click
the dropdown arrow to change the view.

Display all events that occurred within the last day

Display all events that occurred within the last week

Display all events that occurred within a selected period

Display ali events
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Icon Name Click icon to...
‘ Clear Clear the entire log and empty the current event list view
Show User Open the Userwindow for the selected user.
Clear Alarm Open the Alarm Details window to allow the operator to
reset the alarm.
- Antipassback Open the Antjpassback Forgive window to allow the
m Forgive operator to cancel an Antipassback restriction for the
selected user.
* Camera List Open a list of all ViTrax cameras attached to the network
Archive Open the Archive Camera Window for the selected video

stream or snapshot.

4.5 Tree View

The Tree View allows users to configure, monitor, and control every aspect of a
facility's access control network.

When the user selects an element from the Tree View, its contents are shown
in the main display area, and the toolbar icons change to suit the selected
element.

4.5.1 Networks

A network is a group of up to 32 access control panels. The AxTraxNG™
Server connects to the panels across the panel network.

For more information, see Section 5.3.

4.5.2 Timing

The Timing tree branch consists of two elements: time zones and Holidays.
45.2.1 Time Zones

A time zone defines a weekly time period or set of time periods; for example,

" Office Hours" or "Out of Office Hours". Door access rights, alarms, and input
and output behavior can all be set to behave differently within each Time
Zone.

For more information, see Section 5.1.

4522 Holidays

This element defines annual holiday dates; it is possible to set special access
behaviors for holiday time.
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For more information, see Section 5.2.
4.5.3 Groups

The Groups tree branch consists of three elements: Access groups, Input and
Output Groups, and access areas.

45.3.1 Access Groups

An Access Group defines when each reader on the site is available for access.
All site personnel are assigned to appropriate Access Groups.

For more information, see Section 5.9.1.

4532 Input and Qutput Groups

Input and Output groups define sets of outputs or inputs that should be
managed together within a panel.

For more information, see Sections 5.7, 5.9.2, and 5.9.3.

4533 Access Areas

A facility can be subdivided into several access areas to configure and manage
it more effectively.

For more information, see Section 5.12.
4.5.4 Global Antipassback

Antipassback rules can be applied to each access area to prevent one user's
card or entry code from being used for two subsequent entries, and to prevent
a second entry without a previous exit.

For more information, see Section 5.13.

4.5.5 Users

The Users tree branch consists of five elements: Departments/Users, Visitors,
User Filter, Cards, and Operators.

4551 Departments/Users

This element shows a list of all departments and users, as well as any visitors
registered in the system. Each user is a member of a department. For each
user, it is possible to assign cards and/or a PIN code, set access rights, personal
details, and include an identification photograph.

For more information, see Section 5.11.
4552  Visitors
This element shows a list of all visitors registered in the system.

Visitor type users can also be created with specific access rights.
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For more information, see Section 5.11.
4553 User Filter

This element allows you to find users in the database based on various search
parameters, such as name, user number, and access group. The filtered list
then appears in the main window.

4554 Cards

This element lists all cards in the system with their statuses, and allows the
manual or automatic addition of cards to the system.

For more information, see Section 5.10.

4555 Operators

Operators are people with access to the AxTraxNG™ software. The default
operator names are Administrator, Engineer, and Security.

Different operators have wider or more restricted security rights, from
complete control over the system to the ability only to view one section. All
Operator passwords are case-sensitive.

For more information, see Section 5.14.

4.5.6 Status Map

The Status Map creates a graphic display of the statuses for every door, reader,
and alarm in the facility on user-selected images.

The system can display multiple nested status maps, allowing users to show
either the complete access control network or a specific area in detail. For

more information, see Section 5.16.
4.5.7 Reports

AxTraxNG™ can produce various reports, including usage reports, attendance
records, visitors, and roll calls. The AxTraxNG™ Report Wizard allows users to
design their own custom reports based on their needs. For more information,

see Chapter 8.
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The window closes and the new output group appears in the display area.
5.10 Adding Users and Cards

The AxTraxNG™ database maintains a list of every user card or PIN that has
ever been assigned. The Add Users and Cards window is used to define:

*  The type of reader needed to read the card
=  The number of cards to create
«  Whether or not a user should be created for each new card

The Add Users and Cards window contains the following fields:

Field Description

Selection Type Select what will be added: Users and cards, Users only, or Cards
‘only

Quantity Type or select the number of cards/users to add

Sequential cards Define the card properties:

e Reader Type: Select the type of reader appropriate for the
new cards being added

e Start from: Type the number of the first card in the set

¢ Facility code: Type the site code for these cards. This field
is not available for all reader types

Sequential Users —  Define the users general properties:
General e Department: Associate to the new user(s) created to a
department

e Access Group: Associate to the new user(s) created to an
Access group

Sequential Users —  Define the users right properties:
Rights e Antipassback immunity: Select the checkbox to override
any antipassback restrictions
e Extended door open time: Select the checkbox to activate
the extended door option defined for each door

Sequential Users —  Select the checkbox to define automatic pin codes, select
Pin Code between:
¢ Start from: Sequential pin code starting from a predefined
number based on a defined number of digits
¢ Random: Random pin codes where the only definition is
the number of PIN code digits

Sequential Users —  Define the access right validity:

Valid date e From: Define the date and time to begin allowing access
e Until: Select the checkbox to define an end date for the
access right validity, then define the date and time
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Field Description
Sequential Users — Select the checkbox to define associated link commands:
Links

o Access Granted command: Activate a user-defined set of

inputs or outputs for access granted events

e Access Denied command: Activate a user-defined set of
inputs or outputs for access denied events

e Handicapped checkbox: Activate a dedicated output a
short time after the door is unlocked. The outputs are set in

the Links window.

e User selected Output group: Select an output group for
this user. The outputs are triggered every time the user

accesses a door.

‘The operations, inputs, and outputs are defined in the Links

‘window. See Section 5.8.

Sequential Users —  Select the £nable checkbox to use the counter option then type
Counter or select the counter number to be used for the first user

To add users and cards:
1. In the Tree View, select Cards.

2. On the toolbar, click the & icon.
The Add Users and Cards window opens.

Iﬁmrt Users and Cards
Sequential cards
Seloction type Aeadar lype
jludd U sets and Catds | |Wiegand 26 Bits
Quariiy Start lrom (1. To 65535)
\ - 1
Sequential Users

General [ PIN Code

Depaitment = Sianed fromn 1000

| General \RI

- Raricom
Access gloup
| Maste ! alid date
Firom

Rights 29/5/M v.| |oo:00

[ Antipassback Immunity [ Unti
" [ Estended door open time

-~
-

3
Facilty code (0 To 255]
Links
] Access Granted command
[[] Access Denied command
[ Handicapped
User selected Output group
|None %«;I
Counter
[J Enable |3 | (1 to 1000)
——

Figure 62: Add Users and Cards Window

3. Configure the user and card properties as required, according to the field

descriptions in the table above.
4. Click OK to close the window.

The process may take a few minutes after which a dialog reports that the

operation has been completed.
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5.1 Adding Departments, Users, and Visitors

Every user is grouped within a department. For each user, AxTraxNG™ stores
contact details, associated card details, and access rights.

5.11.1 Adding Departments
To add a department:
1. In the Tree View, select the Departments, Users and visitors element.

2. To create a new department, click the e icon.
The Add Department dialog appears.

Department
Desciiption

| Depantrert &

=) (m= )

Figure 63: Add Department Dialog

3. Inthe Description field, enter a name for the department and click OK
The window closes and a new department is created.

5.11.2 Adding Users
Adding users to a department is done by using the Add User window.
The Add User window contains three main tabs:

= Generaltab — Displays identification and control information
= (Codestab — Displays card information associated with the user
= Details tab — Records user contact details

In addition, there are two content-oriented windows:

»  User Fields — Stores user-defined data
= VisitorTab — Appears when the user is defined as a visitor

5.11.2.1  General Tab
The General tab displays:

= User identification information
= User validity settings
= Access rights for the user
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User properties

31 1| Codes (i .Details!

Phato

Add

Calor

. |
Location |

Rights
[] Estended door open time

[] Antipassback Immunity

First Mame ~ Middle name
L _ R U o
LastMName User Mumber
| | 2 3‘ [1 to 1000000)
Department Access group ) -
|Master - v |
‘falid date
From ] Unei |
I__ 2/15/2012 93-| | 2M5/2012
[ [2z59 7]
Counter
[] Enable Counter value
[] Set new counter , _! (1 to 1000)
Linkz
Usar salectad Oulput giotip

[] Access Granted command
[] Access Denied command |
[ Handicapped ‘

MNore |

l - New ] [ Qk ] [ Cancel ]

Figure 64: Add User Window - General Tab

The Generaltab contains the following fields:

Field
Photo - Add

First name
Middle name
Last name
User number
Department
Access group

Select color

Location

Description

Click to add a photo of the user, or to remove an

existing photo. The selected photo aspect ratio should
be 1.25 H x 1.00 L; otherwise, the photo may be
distorted.

Type the user's first name.

Type the user's middle name.

)_ﬁType the user's last name.

Type a unique user number to identify the user.
Select the user's associated department.

‘Select the user's access group.

‘Click to select which color to use to highlight this user
‘when the user generates access events.

User highlighting must be activated in Tools > Options
> General tab.

Click to display a log of doors accessed by this user.
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Field

Valid date/time from
Valid date/time until

(checkbox)
Valid date/time until (field)

Enabled

Set new counter

Counter Value

Rights > Antipassback
immunity

Rights > Extended door open

time

Links > Access Granted
command

Links > Access Denied
command

Links > User selected Output

group

Links > Handicapped check-
box

Description

Select the date/time from when the user's access
rights begin.

‘Select the checkbox to set the date/time on which the

user's access rights end.

Select the date/time on which the user's access rights
end.

This field is only available when the checkbox is
enabled.

Select the checkbox to set an access rights countdown
counter for this user.

When the counter reaches zero, the user's access
rights end.

Select the checkbox to set a new countdown counter
value for this user.

Select a new countdown counter value for this user.
This field is only enabled when the Set new counter
checkbox is selected.

Select the checkbox to override any Antipassback
restrictions for this user.

Select the checkbox to entitle this user to an extended
unlocked door duration. The extended duration is set
for each door. See Section 5.5.

Select the checkbox to activate a link rule initiated by
access granted commands for this user. See Section
5.8.

Select the checkbox to activate a link rule initiated by
access denied commands for this user. See Section
5.8.

Select an output group for this user. The outputs are
triggered every time the user accesses a door, as
specified in the Links window. See Section 5.8.

Select the checkbox to activate a dedicated output a
short time after the door is unlocked. See Section 5.8.
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5.11.2.2 Codes Tab
The Codes tab displays:

= The cards assigned to this user (up to 16 cards)
=  The PIN code assigned to this user

User praperties %]

| General H_-CUdES‘.: Details |

‘ Card Codes
Card Type Faciity Code Card Number Status

| |%  |wiegand268is | Active v

|

AddFromMD-08 . | [ AddFromList... ]

PIN Code
Eumber of digits(4 to 8) Code

=

[ owew [ ok ] 'C,ar;c.el |

Figure 65: Add User Window — Codes Tab

The Codes tab contains the following fields:

Field ‘Description

Card Type The card type used by the reader / user

Facility Code ‘The site code assigned to this card

Card Number The unique number of this card

Status Select the status of the card. Inactive cards cannot gain access to
the facility

Number of digits Select the length of the PIN for this user.
Code Type a PIN.
Auto PIN Click to automatically generate a random PIN.
Add from MD-D08  Click to read card details using MD-D08 module.
Add from list Click to add a new card.
‘All cards within the user's specified facility code, are listed
5.11.2.3 Details Tab

The Details tab contains detailed contact and identification details about the
user.
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mﬁ-pmpertln 2]
| General | Codes i!'c'i'éiae_;""
Telephone Home telephone
Mobie Car teguttation
|
Fax Tille
Email Employment date |
| 1/1/00 v
) |
Address Notes |
|
|
1
| Details._,
[ New J[ ok || cancel |

Figure 66: Add User Window - Details Tab

The Details tab contains the following fields:

Field Description

Telephone Type an office telephone number for the user.
Mobile Type a cell phone number for the user.

Fax Type a fax number for the user.

Email Type an email address for the user.

Address Type a postal address for the user.

Home telephone  Type a home telephone number for the user.

Car registration Type the user's license plate number.

Title Type the user's title (e.g. "Mr.").

Employment Date Enter the date that the user joined the firm.
Notes Type any additional information.

Details Click to open the user's additional details folder.

5.11.2.4 User Fields Tab

The User Fields tab can be used to store any information required by the
system operator.

User fields are defined in the Tools > Options > User Fields/Default tab (see
Section 9.5.2).

To create a user:
1. In the Tree View, expand the Departments/Users element and select a

department for the new user.
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2. On the toolbar, click the % icon.
The Add Userwindow opens.

3. Enter the user details in the various tabs as explained in detail in the
following sections.

4. Click OK.
The window closes and the added user is displayed.

5.11.3 Adding Visitors

AxTraxNG™ stores contact details for each visitor, associated card details, and
visitor access rights.

The Visitor’s options tab contains the following fields:

Field Description

Visitor

Identification Type a unique visitor identification

Visit Date/Time Select the checkbox and specify the date and time for the visit

Automatic disable Define automatic disable access right options

on exit e Access Area: Select the Access Area to disable access to
¢ Inactive card: The designated card automatically becomes
inactive upon exit
e Unauthorized user: the designated access group changes to
Unauthorized upon exit

Hosted ‘Define the details for the hosting party:

e Department: Select the Department
e User: Select the hosting User
o Comment: Type any additional information

To create visitors:
1. Inthe Tree View, expand the Users element and select Visitors.

2.  On the toolbar, click the  con.

The same Add User window as before opens; however, now the Visitor’s
Options tab is available.
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User properties L3}

Genesal | Codes | l}eq.g;i Visitor's oplions_
[0 Automatic dissble o exit
| Visitor identification Access Area

Global v
Visit Date/Time Ophion:
29/5 411 [ @ Inactive card
16:46 2. O Unaulhorized user
Histed
| Depatrnent User
[General v STt D

Comment

Ci JC & J[ e )

Figure 67: User Properties Window - Visitor’'s Options Tab

3. Enter the visitor specific options as needed.

4. Enter the visitor’s details in the various tabs as explained in detail in the
user subsections.

5. Click OK.
The window closes and the added visitor is displayed.

: Users may be moved to other department or redefined as a Visitor. A visitor
!, may be moved into any department and changed to a regular user.

Note Select a user or a visitor row using the mouse and drag & drop it into the
relevant Tree View icon.

5.12 Adding Access Areas

A large site can be divided into several smaller, more manageable access areas.
Reports can be produced individually for each area. In addition, global
Antipassback rules can be applied for each access area. When global
Antipassback rules are in effect, users cannot re-enter an access area until they

have left it.

Use the Access Area window to add entry and exit door readers to and from
an area within the facility.

To add an access area:

In the Tree View, expand the Groups element.
2. Expand the Access Areas element and select Global.

3. On the toolbar, click the ¥ icon.
The Add Access Area window opens.
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Description:
I A_cc:ﬁs Arei 1. 1_

Avallable Readers To Enter. - Eeleitgﬁ eaders To Enter:
[ 1\Panel 1\Reader 1 | [
1\Panel 1\Reader 2 |
1\Parel 2\Reader 1 [ |
T\Panel 2\Reader 2

Available Readers To Exit: I_Silected Readers To Exit
1\Panel 14\Reader 1 I

1\Panel 14Feader 2
1\Panel 2%\Reader 1
14Panel 2\Reader 2

[ OK ]l Cancel ]

Figure 68: Add Access Area Window

In the Description field, enter a name for the access area.

5. Select and move the desired readers from Avarlable Readers to Enterto
Selected Readers to Enter using the arrows.

6. Select and move the desired readers from Available Readers to Exitto
Selected Readers to Exit using the arrows.

7. Click OK.
The window closes and the new access areas appear in the Display Area.

5.13 Adding Global Antipassback Rules

Global antipassback functionality is only enforced when the AxTraxNG™
Server is connected and monitoring the entire access control system.
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To create antipassback rules:
1. In the Tree View, select Global Antipassback.

2. On the toolbar, click the W icon.
The Add Global Antipassback window opens.

Global Anti-p.assback ]
Description
Glcltlal antipaszsback 1
Access Area
[Access Area 1.1 - |

Automatic Antipassback

‘ Never v

O Hard (alarm and access denied)

(® Soft (alarm only]

[ OFK. H Cancel J

Figure 69: Add Global Antipassback Window

3. Inthe Description field, enter a name for the antipassback rule.
4.  From the Access Area dropdown, select the access area.

5. From the Automatic Antipassback dropdown, select the time zone for
which the global antipassback applies.

6. Select either the Hard or the Soft Antipassback option.
7. Click OK.

The window closes and the global antipassback rule appears in the Display
Area.

i Global Antipassback applies an Antipassback event only on "Enter" readers
!‘ to the defined "Area".

Siote To implement Antipassback on Exit readers as well, you must define a new
area with opposite reader directions:

Readers defined "Enter" in the first area need to be defined again in the
new area as "Exit" readers, and "Exit" readers in the first area should be
defined as "Enter" readers in the second area.

5.14  Adding Operators

Operators are people with access to the AxTraxNG™ application. The default
operator name is Administrator.

Different operators have wider or more restricted security rights, from
complete control over the system to the ability only to view one section. All
operator passwords are case-sensitive.
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To define operators:

1. Inthe Tree View, expand the Users element and select Operators.

2. On the toolbar, click the " icon.
The Add Operator window opens.
Opt_:r;tl-Jr ﬁroberties
Description
L
[ Localize guard el iy
Location . Rights
Modify v
Networks ' None s
Configuration ' None v
Dperators ' None N
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[ New I [ oK J [ Cancel
Figure 70: Add Operator Window
3. Inthe Description field, enter the Operator’s name.
4. Select the Localize guard checkbox to define the operator with limited
rights.
5. Click the Networks... and Status maps... buttons to define the
associated operator’s local rights.
6. Set the operators global permission rights for each of the screens in the
Location list.
7. Click Password... to open the Password dialog.

Operator Password
Change password
Current password

New password

Confirm passward

" together with other properties of
operator.

Mote: password will be saved .

[ ok

J |

Cancel

I

Figure 71: Operator Password Window
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8. Enter the operators’ password in the Password field and re-enter the
password in the Confirm Password field.

On first time use, leave the password field empty and enter (and confirm)
!' your new password.

Note

9. C(lick OK to save your settings.
The dialog closes and the operator is shown in the display area.

5.15 Creating Elevator Control
Elevator control can be created by following four simple steps.

Normally, a reader is associated with a door. For elevator control, a selected
reader should be associated with several outputs (floors).

To create elevator control-

1. Assign a reader to the Elevator Control.

2. Inthe Reader Properties window, clear the Open Door checkbox. See
Section 5.6.

3. Create output groups (see Section 5.9.3).
Each output group represents a floor or several floors.

: When creating an output group for the elevator control, the selection only
! applies to outputs from the same panel.

Note

4. Create a panel link (see Section 5.8). Only one panel link is required.
5. Associate Users with Elevator Control Rights

Each user can be associated with the relevant access group to allow user
access to specific floors, as needed.

6. In the General tab of the User window, associate a user with output
groups (see Section 5.11.2.1).

5.16 Creating Status Maps

The Status Map displays the status of every door, input, and output,
antipassback rules, and alarms in the facility on user-selected floor plans.

To set up a Status Map:

1. In the Tree View, select Status Map and click the  icon.
The Add Status Map window opens.






